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1. EVALUATION BOARDS AND DESIGN KITS

1.1 OVERVIEW

This guide gives instructions on how to connect to and operate the evaluation boards for RFMD’s
Integrated Synthesizer/Mixer devices, with focus on the RFFC5071 device and the DKFC507 1 design Kit.
Information on other devices can be found in “Simplified Schematics for Evaluation Boards”. This guide
includes setup information for the evaluation boards and instructions on how to use the programming tool,
sometimes referred to as the GUI (Graphical User Interface).
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Figure 1. RFFC2071 Evaluation Board

RFMD’s integrated synthesizer devices incorporate a proprietary serial interface which is driven from a
software programming tool through a USB-to-serial interface chip. The programming tool programs the PLL
to the desired LO frequency, and enables and biases the mixer(s) as required, while controlling other
features within the chip. Before evaluation of the device can begin, the various software components need
to be installed on a suitable PC, as described later in this document.

These evaluation boards incorporate wideband baluns on the mixer input and output ports to enable
wideband characterization of the device. Performance is improved for narrowband applications by
optimizing the balun type and matching for the frequencies of interest. These boards are fitted with a
26MHz reference oscillator that provides the PLL reference clock. They can be configured to accept an
external reference signal of between 10MHz and 104MHz. A complete circuit diagram and bill of materials
are available.

RF MICRO DEVICES®, RFMD®, Optimum Technology Matching®, Enabling Wireless Connectivity™, PowerStar®, POLARIS™ TOTAL RADIO™ and UltimateBlue™ are trademarks of RFMD, LLC. BLUETOOTH is a trademark owned by Bluetooth SIG, Inc., US.A. and licensed for use by RFMD. All other trade names,
trademarks and registered trader espective 012, RF Micro Devices, Inc.
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1.2 DESIGN KIT DISCLAIMER

These kits are intended for evaluation purposes only. RFMD expressly disclaims all warranties, either
express or implied, including the implied warranties of fithess for a particular purpose and merchantability,
with respect to the use of this design material in connection with the design or use of any product. RFMD
also disclaims all responsibility for any actual, direct, indirect, special, consequential, or incidental
damages incurred by any person resulting from any error or defect in or misuse of this circuit design and
any related specifications or information. These devices have not been authorized as required by the rules
of the Federal Communications Commission. These devices are not, and may not be, offered for sale or
lease, or sold or leased, until authorization is obtained.

1.3 EVALUATION BOARD SETUP

The UM232R interface module on the evaluation board should be connected to a USB port on the PC
running the programming tool. The UM232R is a USB-to-serial interface chip. It has been programmed at
RFMD in order to operate correctly with the programming tool.

Figure 2. FTDI UM232R interface module

The evaluation board comes fitted with a 26MHz reference oscillator providing the reference clock. The
board can be configured for an external reference clock, provided via an SMA connector. This requires the
crystal to be removed and 1nF capacitors fitted to connect the input clock to pin 10 of the chip.

With these connections in place the device is ready to be programmed. The RF and/or baseband ports
(SMA) can be connected to test equipment as required.

Function Type

Power supply (+3V) Banana plugs
RF inputs and outputs SMA

Baseband inputs and outputs SMA

External reference input SMA

UM232R USB-to-serial adaptor | 24-pin DIL (0.6”)
GPOs SIL header
Serial interface DIL header

Table 1. Evaluation board setup details

RF MICRO DEVICES®, RFMD®, Optimum Technology Matching®, Enabling Wireless Connectivity™, PowerStar®, POLARIS™ TOTAL RADIO™ and UltimateBlue™ are trademarks of RFMD, LLC. BLUETOOTH is a trademark owned by Bluetooth SIG, Inc., US.A. and licensed for use by RFMD. All other trade names,
trademarks and registered trademarks are the property of their respective owners. ©201: 0 Devices, Inc.

120227 7628 Thorndike Road, Greensboro, NC 27409-9421.For sales or technical support, contact RFMD at (+1) 336-678-5570 5 of 25
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1.4 PREPARING THE FTDI UM232R UART TO CONTROL A DEVICE ON A USER’S OWN BOARD

If the following conditions are met the programming tool automatically detects whether the board being
used is configured as a MultiSlice board or has a single device. It will also be able to detect which device is
being used on the board and display appropriate graphics to aid programming;:

1. |If using a new UM232R, the correct code needs to be used in the module. The code is available
from RFMD.

2. The control lines must be connected to the device(s).

3. Two signal lines on the USB interface must be correctly terminated to ensure the programming
tool operates in the correct mode (single device or MultiSlice).

Installing the FTDI UM232R USB drivers

If this is the first time connecting the FTDI UM232R, “Device not found” and a dialog box display. Install
the USB drivers.

To install the FTDI UM232R USB drivers:

1. Select “No, not this time”.

2. Select Next.

3. Select “Install from a list or specific location (Advanced)”.
4. Select Next.

5. Select “Don’t search, | will choose the driver to install”.

6. Select Next.

7. Select “Show all devices”.

8. Select Next.

9. Select Have Disk...

10. Select Browse.

11. Navigate to FTDI and select the driver .inf file.
12. Select Open.

13. Select OK. The driver installs.

RF MICRO DEVICES®, RFMD, Optimum Technology Matching®, Enabling Wireless Connectivity™, PowerStar®, POLARIS™ TOTAL RADIO™ and UltimateBlue™ are trademarks of RFMD, LLC. BLUETOOTH is a trademark owned by Bluetooth SIG, Inc., US.A. and licensed for use by RFMD. Al other trade names,
trademarks and registered trademarks are the property of their respective owners. ©2012, RF Micro Devices, Inc.

120227 7628 Thorndike Road, Greensboro, NC 27409-9421.For sales or technical support, contact RFMD at (+1) 336-678-5570 6 of 25
or customerservice@rfmd.com.
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1.5 SIMPLIFIED SCHEMATICS FOR EVALUATION BOARDS
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Figure 3. RF2051/RF2056/RF2057/RF2059/RFFC2071/RFFC5071
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Figure 4. RF2052/RF2053/RFFC2072/RFFC5072

RF MICRO DEVICES®, RFMD, Optimum Technology Matching®, Enabling Wireless Connectivity™, PowerStar®, POLARIS™ TOTAL RADIO™ and UltimateBlue™ are trademarks of RFMD, LLC. BLUETOOTH is a trademark owned by Bluetooth SIG, Inc., US.A. and licensed for use by RFMD. Al other trade names,
trademarks and registered trademarks are the property of their respective owners. ©2012, RF Micro Devices, Inc.
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Figure 5. RFMD2080
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Figure 6. RFMD2081
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2. THE PROGRAMMING TOOL

2.1 DOWNLOADING AND INSTALLING THE TOOL

Download the programming tool software from http://www.rfmd.com/products/IntSynthMixer/default.aspx.
The FTDI USB drivers are also available for download.

Figure 7. RFMD’s Software Download Site
To download and install the programming tool software:

1. Go to the landing page for integrated synthesizer/mixer parts at
http://www.rfmd.com/products/IntSynthMixer/default.aspx.

2. Go to the GUI Software Tools towards the bottom of the page.

3. Click on the link for the latest version of the code.

4. Open the .zip file and run the setup.

2.2 RUNNING THE TOOL WITH NO DEVICE PRESENT
It is possible to run the programming tool with no device present. This allows the user to:

= get a feel for the way the programming tool works.

= explore the register contents and evaluate register settings,such as register settings for a given VCO
frequency.

= use the other tabs within the programming tool.

If the application is started with no device present, a warning box displays indicating the device is not

connected:

RF MICRO DEVICES®, RFMD, Optimum Technology Matching®, Enabling Wireless Connectivity™, PowerStar®, POLARIS™ TOTAL RADIO™ and UltimateBlue™ are trademarks of RFMD, LLC. BLUETOOTH is a trademark owned by Bluetooth SIG, Inc., US.A. and licensed for use by RFMD. Al other trade names,
trademarks and registered trademarks are the property of their respective owners. ©2012, RF Micro Devices, Inc.

120227 7628 Thorndike Road, Greensboro, NC 27409-9421.For sales or technical support, contact RFMD at (+1) 336-678-5570 9 of 25
or customerservice@rfmd.com.
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Failed to find appropriate hardware.

The Application was not able to communicats with hardware.
Pleass maka sure the LISB is connacted andthe correct driver installed,

Press <Ignore> to continue without hardware.
Press <Retry > to try again.
Press <Abort> to quit the Applcation,

[_mbot | [ mety J[ igoore |

Figure 8. Warning that displays when the programming tool starts with no device connected

Selecting Abort closes the software. Selecting Retry causes the programming tool to attempt to reconnect
to the device (this may be required if the supply is not connected to the device or the device is not
present). Selecting Ignore lets the software continue to run without a device present, as shown below:

EE

Fil=:  Corfiguration  Emulating Hardware & Help
Evaluate lDashbDald] Heg\sterAccess] Loop filter] Frequency Counler] Wit Page] RFMD News]
Frequency bz (915000000 | [315000000 | -_
0 6000
J J Frequency iMHz)
Linearity
(%) Standhy ) Path 1 ) Path 2
[] Full duples
Reference frequency selection
Reference frequency: 26 MHz
Reference divide ratio: i
FPhase detector frequency: 26.000 MHz
Freq. resaolution: 1.550 Hz
Update
) Emulating Hardware Device : RFZ051 rew3 (0x0003) Lock Detect

Figure 9. The programming tool running without a device present

The tool behaves as if an RFFC5071 device were connected but the lock detect indicator is not working.
Any attempt to read the device register contents will produce a warning. It is still possible to save the

register contents to a file. Change the emulated device using the “Emulating Hardware” pull-down menu.

This allows selection of RFFC5071, RFMD2080, or RF2051.

If the initial attempt to connect the chip to the computer has accidentally failed, select Retry after
connecting the device. This will allow the software to connect.

RF MICRO DEVICES®, RFMD®, Optimum Technology Matching®, Enabling Wireless Connectivity™, PowerStar®, POLARIS™ TOTAL RADIO™ and UltimateBlue™ are trademarks of RFMD, LLC. BLUETOOTH is a trademark owned by Bluetooth SIG, Inc., US.A. and licensed for use by RFMD. All other trade names,
trademarks and registered trademarks are the property of their respective owners. ©2012, RF Micro Devices, Inc.

120227

7628 Thorndike Road, Greensboro, NC 27409-9421.For sales or technical support, contact RFMD at (+1) 336-678-5570
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10 of 25




RFMD

Eval Board and Programming Tool Guide for Mixers and Modulators with Integrated Synthesizers

rfmd.com

2.3 RUNNING THE TOOL WITH A DEVICE PRESENT

Pull-down resistors on the boards allow the software to automatically determine whether MultiSlice
operation is required. Descriptions in the text generally refer to the RFFC5071; however these will be
applicable to other related parts as well.

If a device is detected when the software starts the the Evaluate tab displays. The user can perform basic
operations on the device such as changing the frequency or the device linearity. This is described further
later in this document.

Please note that when the programming tool starts it performs a few housekeeping tasks to determine
which device is connected and what the register contents are. This means that a number of writes and
reads to and from the device are performed. In normal operation these would not normally be required and
should be ignored if the user is monitoring the serial bus during this period.

2.4 STATUS INDICATORS

L PG e[

— riesel l

) No Hardware found. Jevice ID: Unknown Lock Detect

Figure 10. Status indicators at the bottom of the programming tool window

Within the programming tool, in an information bar at the bottom of the window, there are three indicators
showing the status of the device.

= On the left is the status of the USB interface module. If that hardware is present a green circle
displays. If not, the circle is yellow.

= |f a device is present, the device ID number displays in the center of the information bar when the
programming tool reads the CHIPREV field within the device and checks it has a valid value.

= The third indicator (displayed in the Evaluate tab only) is the synthesizer lock status. This displays a
green circle if the device has been enabled. Grey indicates the device is in standby mode. Orange
indicates the synthesizer is not locked.

RF MICRO DEVICES®, RFMD®, Optimum Technology Matching®, Enabling Wireless Connectivity™, PowerStar®, POLARIS™ TOTAL RADIO™ and UltimateBlue™ are trademarks of RFMD, LLC. BLUETOOTH is a trademark owned by Bluetooth SIG, Inc., US.A. and licensed for use by RFMD. All other trade names,
trademarks and registered trademarks are the property of their respective owners. ©201: 0 Devices, Inc.

120227 7628 Thorndike Road, Greensboro, NC 27409-9421.For sales or technical support, contact RFMD at (+1) 336-678-5570 11 of 25
or customerservice@rfmd.com.
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2.5 PROGRAMMING TOOL TABS

There are six tabs providing access to device programming and additional features.
Evaluate | Dashboard | Register access | GPO | Loop fiter | RFMD News

Figure 11. Programming Tool Tabs
2.5.1 Evaluate Tab

The Evaluate tab gives controls mixer selection, operating frequency, and mixer linearity.

SEE
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Figure 12. The Evaluate tab, showing the linearity graph in duplex mode

1. Set operating frequency by entering a new frequency (in MHz) into the appropriate box. Operating
frequency is shown graphically via the frequency bar to the right. If an out-of-range value is
entered (for example, an LO frequency that is too low) the value displays in orange to indicate the
error.

2. Set mixer linearity using the Linearity sliders. Linearity and current consumption are shown by the
graph on the right. In full duplex mode two linearity graphs are shown, one for each path.

3. Set desired state (Standby, Mixer 1 operating, or Mixer 2 operating) using the Control Mode
Hardware Pins radio buttons.

RF MICRO DEVICES®, RFMD®, Optimum Technology Matching®, Enabling Wireless Connectivity™, PowerStar®, POLARIS™ TOTAL RADIO™ and UltimateBlue™ are trademarks of RFMD, LLC. BLUETOOTH is a trademark owned by Bluetooth SIG, Inc., US.A. and licensed for use by RFMD. All other trade names,
trademarks and registered trademarks are the property of their respective owners. ©2012, RF Micro Devices, Inc.

120227 7628 Thorndike Road, Greensboro, NC 27409-9421.For sales or technical support, contact RFMD at (+1) 336-678-5570

or customerservice@rfmd.com.
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8.

Set duplex mode (both mixers operating) by selecting Full Duplex.

Set reference frequency division ratio via the Reference Divide Ration dropdown menu. The
corresponding phase detector frequency displays below the dropdown.

PLL lock detect status displays in the bar at the bottom of the window.

When the frequency changes the display shows a blue background to indicate that the new
frequency has not yet been programmed into the device. Select Update to calculate the required
register values and program the device. The Update button is unavailable if there is nothing to
program.

Select Reset to restore the default status of the device.

Please note that when using this tab a number of additional read/write operations are performed on the
device to determine the type of device present and the status of the lock flag to control the lock indicator.
If monitoring the serial bus reads and writes to check against the user’s own board, use the Dashboard tab
where extraneous read and writes are not performed.

2.5.2 Dashboard Tab

The Dashboard tab gives more control over device functionality while ensuring that illegal values are not
programmed into the device (for example, if an LO frequency is entered that is too low). The device is only
changed when Update is selected. Until then, changed values are highlighted.
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Figure 13. The Dashboard tab, displaying prescaler divider output frequency

RF MICRO DEVICES®, RFMD®, Optimum Technology Matching®, Enabling Wireless Connectivity™, PowerStar®, POLARIS™ TOTAL RADIO™ and UltimateBlue™ are trademarks of RFMD, LLC. BLUETOOTH is a trademark owned by Bluetooth SIG, Inc., U.S.A. and licensed for use by RFMD. All other trade names,

trademarks and registered trademarks are the property of their respective owners. ©2012, RF Micro Devices, Inc.
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The central panel shows a block diagram of the device indicating the active circuit blocks. The image
shown depends on which path has been selected and whether the device is in full duplex mode. The signal
path within the device is selected using the radio buttons (Path 1/Path 2) and the Full Duplex check box.

As shown in the diagram, additional information (prescaler divider output frequency, in this example) about
the device operation displays when the mouse pointer hovers over the circuit.

1. Select a value from the reference divider dropdown menu to determine the phase detector
reference frequency.

2. Select bias current settings (independent for each path within the device) to set the mixer bias
current (mixer linearity), the LO buffer current, and the VCO bias current.

3. Enter a value into the Local Osc Frequency box to determine the operating frequency for the local
oscillator.

4. Enter the integer and fraction parts of the divider ratio to program the synthesizer registers. Enter
the LO division ratio required to achieve the desired LO frequency and the VCO number to select
the correct VCO.

5. Vary the charge pump current in the VCO chain by selecting a value from CP Def. This allows
optimization of the loop bandwidth if required. The Mixer Bias dropdown menu varies the mixer
bias current to trade off mixer linearity for power consumption.

2.5.3 Register Access Tab

The Register Access tab gives access to all the registers within the device.
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Figure 14. The Register Access tab
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The register contents can be edited in a number of ways:
e The hexadecimal value of the register contents can be entered in the box below the register name.

e The binary values of individual bits can be edited in the editable fields to the right of the Write
button. Double-clicking the value toggles between 1 and 0.

When field values are edited they are highlighted to indicate that they have not yet been programmed into
the device.

1. Select Write to independently program individual registers. Select Read to display the current
value of the register. Use the Read All and Write All buttons to read from or write to the chip’s
entire register set.

2. Select Reset Chip to perform a hard reset on the chip. This will not change the register contents
displayed so there is an option to reprogram the registers as before or read back the chip register
contents which will contain their default values.

3. Use the search facility (n) to search the register contents for a particular field. Double-click the
field name in the search results to display the register’s values. The actual register map presented
will vary depending on the device connected.

) Find Field or Register =11

FindWhat: [gpo @
] Match case 7 Matches Found

ﬁ:’;;tﬁ Address  Fielc Name Bit Fisld Descrption =
SDI_CTRL 015 | sdi_e_pn_chil [15] | ‘When sdi_or_pin_ctil=1 enbl and moc
SDI_CTAL 0415 | sdwe_en [12] | IfhighSDI is a 4 wire SDI fie. SDATA
SDI_CTAL 0415 | sd_sddpage_sel | [11] | Iflow, then GPIO1,GPID2 are GPO's
GPO 016 115:9] | GPIDs for Path 2. 1=high. 0 = low. GF
ren AR | anin o1 199 | GDINe fre Bathh 1 1 ohinks N = b RE
< >

Figure 15. The Search facility

4. The registers displayed in this tab will depend on the device present or being evaluated since not
all registers are valid for all devices.
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2.5.4 GPO Tab

The GPO tab controls the general purpose outputs available on the device.

21} RFMD Slice Programming Tool Il ¥ 1.1.00
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Figure 16. The GPO tab

All GPOs have an alternative function depending on the status of the bits represented in this tab. If
MultiSlice is enabled, then GPO1 and GPO2 become inputs setting the chip address. GPO3 can be set as
the modulation control input and/or as serial data output (as an alternative to the multiplexed data stream
on the SDFATA pin). GPO4 can be set to be a lock detect indicator.

GPOs that are not available with the current configuration may not be selected. Their current function
displays.

It is also possible to control the device via the serial bus by setting the appropriate bit in the registers. In
this case the MODE and ENABLE pins become available as GPOs. The MODE and ENABLE pins on the FTDI
device are tri-stated for this purpose.

RF MICRO DEVICES®, RFMD®, Optimum Technology Matching®, Enabling Wireless Connectivity™, PowerStar®, POLARIS™ TOTAL RADIO™ and UltimateBlue™ are trademarks of RFMD, LLC. BLUETOOTH is a trademark owned by Bluetooth SIG, Inc., US.A. and licensed for use by RFMD. Al other trade names,
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2.5.5 Loop Filter Tab

The Loop Filter tab calculates the values for the passive and active configuration of the loop filter.

21} RFMD Slice Programming Tool Il ¥ 1.1.00
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Figure 17. The Loop Filter tab

1. Enter the desired loop filter bandwidth in the Loop Bandwidth box. The VCO frequency, charge
pump current, and phase detector frequency display based on the figures used in the Dashboard
and/or Evaluate tabs. These can be changed if necessary. The nominal VCO gain of 20MHz
displays in the VCO gain box by default, although an alternative value may be entered.

2. Select Calculate button to determine the values of the loop filter components.

RF MICRO DEVICES®, RFMD®, Optimum Technology Matching®, Enabling Wireless Connectivity™, PowerStar®, POLARIS™ TOTAL RADIO™ and UltimateBlue™ are trademarks of RFMD, LLC. BLUETOOTH is a trademark owned by Bluetooth SIG, Inc., US.A. and licensed for use by RFMD. Al other trade names,
trademarks and registered trademarks are the property of their respective owners. ©2012, RF Micro Devices, Inc.
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2.5.6 RFMD News Tab

The RFMD News tab display information on the part and hyperlinks to the RFMD web site.

2} RFMD Slice Programming Tool Il ¥ 1.1.00
File  Configuration @ Help

Evaluste | Dashboard | Register access | GPO | Loop fiter  RFMD News ‘

RFMD2080

RFMD2081

Introducing our new
5GHz broadband
PLL/VCO/mixers:

Iea&ing !;erformance -‘-

- - hitkp: fwovw rFrnd  comfproducts{IntSynthMixer |
and integration ' _WI
i
U World’s most versatile, low power

RF frequency converter chips inside

e em e em
W

© Host Interface Status. Device : RFFCS071 rev (0x8EDL)

Figure 18. The RFMD News tab default page

The image above shows the default page, though other timely information (such as updated product
information, new product releases, etc.) displays if the computer running the programming tool has an
active connection to Internet.
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2.6 MENU OPERATIONS

»)} REMD Slice Programming Tool Il ¥ 1.1.00

Fila  Confioration  MOD DC Conbrol & Haln
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Figure 19. Programming Tool Menus

The File menu provides facilities to:

e |oad and save the register/chip contents

e print the programming tool display

o exit the programming tool (the same as pressing the Close button)
The Configuration menu provides access to advanced settings for:

e crystal properties

e VCOrange

e frequency stop control

e tri-state control

o frequency hop control
The MOD DC Control menu provides facilities to:

e control RFMD2080 settings
The Help menu provides facilities to:

e check for software updates

e display version information
2.6.1 Saving Register Contents
From the File menu the register contents can be saved as shown in the programming tool or as stored in
the chip. The file is saved with a .rfreg suffix but is in an Microsoft Excel format. This file may be edited by
hand if required, but this should be done carefully to ensure the correct format is maintained so that the
programming tool can read it back again.

2.6.2 Loading Register Values

To load a set of register contents from a file, use Load Register Settings from the File menu. Select Update
to store the settings in the device.

2.6.3 Crystal Properties
From the File menu, display crystal properties may be displayed via the Crystal Tune Control Panel. This

dialog allows adjustment of the internal load capacitance applied to the crystal frequency used in the
programming tool to calculate the register contents.

RF MICRO DEVICES®, RFMD, Optimum Technology Matching®, Enabling Wireless Connectivity™, PowerStar®, POLARIS™ TOTAL RADIO™ and UltimateBlue™ are trademarks of RFMD, LLC. BLUETOOTH is a trademark owned by Bluetooth SIG, Inc., US.A. and licensed for use by RFMD. Al other trade names,
trademarks and registered trademarks are the property of their respective owners. ©2012, RF Micro Devices, Inc.
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Figure 20. Crystal Tune Control Panel

The reference frequency is the frequency of the crystal used with the device. The standard Evaluation
Board is fitted with a 26MHz TCXO (depending on device variant) but any frequency between 10MHz and
52MHz could be used. The reference frequency selected is displayed in the Evaluation and Dashboard
tabs of the programming tool.

The slider adjusts the value of the crystal load capacitance within the device (for use with devices that use
an external crystal).

2.6.4 VCO Range Adjust

From the Configuration menu, use this option when a first generation device is attached to allow the user
to set the frequency range of the on-chip VCOs.

2.6.5 Frequency Step Control

From the Configuration menu, use this option to configure the GUI to allow the local oscillator frequency to
be changed in discrete steps in the Evaluate tab. This is useful when performing measurements that
require sweeping the LO frequency.

2.6.6 Tri-State Controls

Use this option in the Configuration menu to set the control lines into a high-impedance state if controlling
them manually using external signals is desired.

2.6.7 Frequency Hop Control

This option in the Configuration menu allows for switching control between the two paths on the device to
allow settling time measurements to be performed more easily.

2.6.8 MOD DC Control

If an RFMD2080 device is connected to the GUI, this menu allows control of the internal DC offset control
DACs and the input low pass filter bandwidth.

2.6.9 Help
The Help menu provides a feature to check for updates to the programming tool and an About RFSlice GUI

popup which displays software version information. If a problem is experienced with the software it would
be useful if the information contained in this box could be included in any correspondence (to copy an

RF MICRO DEVICES®, RFMD®, Optimum Technology Matching®, Enabling Wireless Connectivity™, PowerStar®, POLARIS™ TOTAL RADIO™ and UltimateBlue™ are trademarks of RFMD, LLC. BLUETOOTH is a trademark owned by Bluetooth SIG, Inc., US.A. and licensed for use by RFMD. All other trade names,
trademarks and registered trademarks are the property of their respective owners. ©201: 0 Devices, Inc.
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image of the box to the clipboard for pasting into an e-mail, press Ctrl+Alt+PrintScreen when the About
popup window is active).

About RF207x

RFShce GUI I
Wersion 1.0

Copyight © 2009
RF Micio Devices

Pre-Relears GUI Software Yersion V0.0.5
Assembly Varsion 1.0.3793. 26831

UISB Connacted
Sernial Number Inabd

FTDI Driver3.1.7
RFMD Driver \Wasp Ver 3.1.00
COM Aszenbly Version 3.2 3772 24326

RFMDE)

Figure 21. About popup displaying software version information

2.7 MULTISLICE OPERATION

The programming tool software has been programmed to detect whether multiple devices are present on
the programming bus. The programming tool does this by interrogating the status of two pins on the USB
interface module (pins 8 and 10). If only a single device is present on the bus, both pins are set to High or
left floating (there are internal pull-ups on the FTDI device).

If multiple devices are present, pins 8 and/or 10 on the FTDI device should be set to Low. In this case,
MultiSlice capability enables up to four devices to be individually controlled from the programming tool.

Select MultiSlice Mode in the Evaluate tab to enable this feature in all the devices connected to the serial
bus. All devices will then have to be programmed separately according to the state of GPO1 and GPO2.

If it is necessary to regain control of all the devices they should be reset.

RF MICRO DEVICES®, RFMD®, Optimum Technology Matching®, Enabling Wireless Connectivity™, PowerStar®, POLARIS™ TOTAL RADIO™ and UltimateBlue™ are trademarks of RFMD, LLC. BLUETOOTH is a trademark owned by Bluetooth SIG, Inc., US.A. and licensed for use by RFMD. All other trade names,
trademarks and registered trader espective 012, RF Micro Devices, Inc.
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4. APPENDIX: PROGRAMMING THE UM232R

The UM232R module is a USB - Serial universal asynchronous receiver/transmitter (UART). When shipped
with an evaluation board the UM232R is already programmed. However, if a new device is purchased it
needs to be programmed in order to operate with the evaluation board.

For more information on the UM232R module, visit
http://www.ftdichip.com/Products/EvaluationKits/UM232R.htm.

m
m W

Figure 22. Layout of the UM232R UART
To program a new UM232R:

1. Ensure that the shorting link on header J1 is fitted on pins 1 and 2 as shown above. This sets the
interface voltage level to +3.3V.
2. Leave the shorting link fitted on header J2 in place, this sets the UM232R to be powered from the
USB bus.
3. Download the EEPROM programming tool (MProg) from
http://www.ftdichip.com/Resources/Utilities.htm.
Connect the UM232R to the spare USB port on the PC. A USB type-A to type-B cable is required. When the
device is connected a Found New Hardware dialog displays “UM232R USB Adaptor”. If so, then the FTDI
UM232R drivers are not already installed on the PC. In this case, use the New Hardware Wizard to install
the drivers see ”

4. Installing the FTDI UM232R USB drivers”.
5. Run the MProg utility.
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MProg - Multi Device EEPROM Programmer V 3.0a
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Figure 23. MProg Programmer

Select File>Open.

Browse to the correct directory and select the .ept file for the RFMD Slice Il Programmer.
Select Device>Program. The device has been programmed and a serial number displays in the
window at the bottom of the programming tool

o ~No

MProg - Multi Device EEPROM Programmer ( Program Mode )
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Figure 24. MProg Programmer, displaying device serial number
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9. Confirm operation by disconnecting the USB cable from the UM232R, then reconnecting it. In the
bottom right hand side of the PC screen there will be a small window displaying information on the
USB hardware which should display “Found New Hardware RFMD Bit Banger”.
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